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IGIC 2017 - QGIS WORKSHOP 
Short Presentation Before getting started​! 
Find workshop Materials zip file here. 

Link to most recent version of this document. 
 

QGIS features referred to will be in a ​purple ​font. 
Files in “qgis_igic2017” directory referred to will be in a ​red ​font.  

“Tip Stops,” or ​helpful notes​, will appear in a grey box like this one.  
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1. Introduction to GUI  
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Plug Ins: 
This one was created by Justin! 

 
 
 
Time Manager​ Plugin (8:05) 
 
To View Session History & Errors 
View>>>Panels>>>Log Messages Panel 
(just discovered this recently!) 
 
 
 
 
 
 
 
 
 
 
 

 

https://www.youtube.com/watch?v=9JucLaZrARI
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2. Loading & Exploring A Map 

A. Loading Data/Layers 

>>> Click Add Vector Layer icon:   
 

This window should pop up: 

 
 
>>>Be sure that Source type ​File ​is selected.  
>>>Click ​Browse ​and select: ​shapefiles/roads.shp​ from the “Indy” Dataset.  
>>>Click ​Open​.  
>>>Do the same for: buildings.shp​,  

natural.shp​,  
places.shp​, and  
Stream.shp​. 

 
 

Tip Stop​:​ you can drag the shapefiles into QGIS! 
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B. Exploring Layer Attributes  

>>>Click ​Open Attribute Table​ icon:   

 
 
 
Bonus​: What is another way of getting to the​ Attribute Table​? 
 
 

Tip Stop​: You can make selections from inside the table, add/delete fields, and much more. 
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C. Identifying Features 

>>>Click ​Open Identify Features​ icon:  
 

Your cursor will change​ and will have an “i” attached to the pointer.  
>>>In the ​Layers Panel​, select the layer you want to investigate.  
>>>Click on any feature in the selected layer. 
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D. Feature Selection/Querying 
Feature selection in QGIS will be familiar for those who have experienced it in ArcGIS. It works 
basically the same way. There are many ways to select data from layers. We will go over a few.  

 
>>>In the​ Layers Panel​,  click on the layer of interest. 

>>>From the menu bar, click ​Select Feature by Area​: . 
>>>Try clicking on individual features ​in the selected layer​.  
>>>By holding down the ​shift ​or ​ctrl ​key, you can select multiple features! 
>>>You can ​also draw a rectangle​ which selects all of the features within it.  
 
A few more ways to select: 

>>>Click on the arrow next to the ​Select Feature by Area​ button:  
>>>Try ​Select Features by Polygon​. 
>>>Draw your own polygon and ​right click​ to close it.  
>>>Explore ​Select Features by Freehand​ and ​Select Features by Radius 
 

 

Tip Stop​: ​The ​default selection color​ is bright yellow. If you wish to 
change this, go to:  

Project > Project Properties > General > Selection color 

 

Tip Stop: ​If you wish to ​pan around the map while in “selection mode,”​ and 
if you’re using a mouse, you can hold down the middle scroll bar and 

panaway! 

 
 
 
 
Item of interest: ​Selection Sets plugin 
 
 
 
 
 
 
 
 

https://github.com/NathanW2/selection-sets
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3. Labeling 
For ​Buildings​, what field should we use to label? 

A. Using & Changing Labels 

 
 
>>>Move through the Label editing tabs and explore different ways to change labels. 
 

Tip Stop​: ​Another way to access Layers/Symbology: 

 

This is how we will edit moving forward. It offers greater visibility and 

“Live Updating.” 
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B. Road Labels 
 
>>>Be sure to have ​“Live Updates​” Checked 
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C. Scale-Based Labeling  
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4.Symbology (aka Styling) 

A. Changing Colors  
>>> Set it to any color of your choice! 
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B. Draw Effects 

In the symbology window for the building layer, check ​“Draw Effects” ​and click on the​ Star . 
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C. Rule-Based Symbology: Polygon Layer 
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>>>Double-Click on the ​‘Dorms’ ​rule to open editing dialog. 

 
A ​good example​ of using rule-based symbology. 

 

 

 
 

https://nathanw.net/2011/06/06/one-of-my-favorite-features-of-qgis/
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D. Preset Symbols 

 

E. Rule-Based Symbology: Line Layer  
In this lesson, we will edit the symbology in the ​roads layer​ in order to ​distinguish between 
roads ​and ​paths​.  
 
>>>Proceed as outlined in ​lesson 4C​. Name existing rule​ ‘Roads.’​ Add a rule and name it 
‘Paths​.’ 
>>>Change the transparency of the ‘Roads’ rule to 65% (right-click and select “​Change 
Transparency​). 
>>>Filter the ​‘Paths’ ​rule with the following expression:  ​"highway"  =  'footway'  
>>>Under ​Simple Line​, change the color to any shade of red.  
>>>Change the ​Pen style​ to ‘Dot line’ 

 
Check out another way to style layers: ​Geometry Generator Symbol Layers​. (​Tapered Rivers​) 
 

https://anitagraser.com/2017/04/08/a-guide-to-geometry-generator-symbol-layers/
https://anitagraser.com/2017/04/17/better-river-styles-with-tapered-lines/
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5. Map Composer 
Now we can make a map with QGIS’s Map Composer! 

A. Basic Composition 
 
Project > New Print Composer 

 
(Or ​Ctrl + P​.) 
 
>>>Name the Composer 
>>>A new window will open 

>>>Click the ​Add new map​ icon  
>>>​Drag the cursor​ across the canvas to the extent you want the map to appear. 
>>>Under Main properties, click “​Set to map canvas extent​” to ​sync composer with map 
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B. Title & Legend 

>>>​Add new label​  

>>>​Add new legend​  
 

C. Exporting 

 
 
 

Inspiration!​ Gallery of QGIS ​Cartography 
 
 
 
 
 
 
 
 
 
 

https://www.flickr.com/groups/qgis/pool/
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6. Classification & Joins 
For this section, we will move to a different dataset - ​IndianaMap County Census Data. 

A. Ratio Classification 
We will look at population density in Indiana counties.  
 
>>>​New Project 
>>>Import shapefile from ​IN Census Data​ folder 
 
Change Layer Styling: 

 
 

The layer is going to “disappear”! But don’t be frightened, as I was the first time. It will be 
invisible until we classify it. See below! 
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Set desired parameters and click “Classify”: 

 
 
 

Tip Stop:​ You can also do rule-based, like we did in the Symbology section.  

 
 

B. Join Tabular Data to Shapefile  
 
I found a ​great scraped dataset​ of 2016 Presidential voting data by county: 

 
I am interested in visualizing the​ “per_point_diff”​ field. This will show us which counties were 
more split in the election than others. I grabbed all of Indiana’s 92 counties. 
 
***The problem is that ​when a csv is imported into QGIS, each field is assumed to have a 
“string”​ data type. We need to create a sidecar (‘buddy’) file to accompany the csv. This file will 
specify the data type of each field. To simplify things, I just kept three fields: ​county, fips,​ and 
per_point_diff. 
 

https://github.com/tonmcg/County_Level_Election_Results_12-16


21 

This is what the buddy file looks like:  

 
 

>>>From the ​Layers Panel​ on the left, select ​Add Delimited Text Layer​ . 
 
>>>Specify parameters like so: 

 
 
>>>Let’s check the layer’s data types. ​Layer Properties>Fields​. 

>>>Try to drag the csv in and look at the data types. They’re all strings! 
 

>>>Now Look at the csv’s ​Attribute Table​. 
>>>Will the​ “county”​ field be the easiest to join? If not, which one would be better? 
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>>>Go to the ​census data’​s ​Layer Properties​ and to the ​Joins ​section. 
 

 
 
 
Now apply graduated symbology technique for the ​“per_point_diff”​ field! The lighter the 
county, the more even the political field.  
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7. Creating Vector Data 
Let’s see how easy it is to ​create our own shapefiles​! 
 
>>>​New Project 
>>>Create a Shapefile: 

 
 
>>>Name the file whatever you want and save it in the ​“Vector Creation” ​folder. 
>>>Open the attribute table. Oh, nothing there! 
 
>>>Import the ​IN2014_31001430_06.tif​ file into QGIS from the ​Vector Creation>Bloomington 
Aerial​ folder. This is a small section of Bloomington. File courtesy of ​Indiana Spatial Data Portal​. 
 

http://gis.iu.edu/
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Let’s trace some buildings! 

>>>Click on the ​Toggle Editing​ button to enable the feature editing tool.  

>>>Trace a building using the ​add feature​ icon . ​Right click​ when you want to finish the 
polygon.  
>>>Fill in the fields as you desire!  
>>>Repeat the process for one or two more buildings. 

>>>Now use the move feature(s) icon  to reposition your polygons.  

>>>If you want to a more fine-tuned edit of your polygon select the Node tool . Select a 
node and move it around as you wish.  

>>>Click  to save your layer edits.  

>>>​You can also copy, paste and cut features!      
 
Neat Sidenote 
Add OSM roads layer. What’s up with Vernal Pike?! ​Tiff is from 2014!​ OSM is quick! 
(Vernal Pike on ​Google Maps​!) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.google.com/maps/place/Bloomington,+IN/@39.177652,-86.5609224,653m/data=!3m1!1e3!4m5!3m4!1s0x886c5df6b483d8e7:0xe91a912d8bad33d9!8m2!3d39.165325!4d-86.5263857
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8. Feature Topology 
This section will go over ​basic topology editing in QGIS​. The software has many advanced 
features in this area and deserves much more exploration.  

A. Snapping 
Sometimes we may want to Edit topological features already created. The first step in properly 
doing so is enabling feature ​Snapping​. 
 
First, add in all of the OSM layers from earlier. 
 
Enable Snapping: 

 
 
 
Be sure you have the ​Digitizing Toolbar​ visible. 
If not, go to ​View>>>Toolba​r and Select ​Digitizing Toolbar​. 
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Enable editing on ​landuse​ layer and click on the ​Node Tool​, like so: 

 
 
Now you can edit the polygons by moving the nodes. They will ​snap ​more easily to other 
features. ​Double-click​ anywhere on the polygon border to create additional nodes. 
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B. Advanced Digitizing Toolbar 
Right-click​ in toolbar area. Under ​Toolbars ​select​ ‘Advanced Digitizing Toolbar’ 

Rotate Feature: 

 
Simplify Feature: 

 
Notice how the # of nodes decreases as the tolerance goes up. This is a very neat feature! 
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C. Add Part 

Use the ​Add Part​ button ( ) to add to an existing polygon.  
 

Tip Stop​: Remember, a right click closes the polygon. 

 

D. Split & Merge Features 
 
>>>Be sure snapping is enabled for the ​landuse ​layer. 

>>>Click ​Split Features​ -  - and cut a polygon by selecting two nodes across from one 
another. You will now see two distinct polygon where there was only one before.  

>>>Now select both features and then click ​Merge Selected Features​ - . 
>>>Click ​OK​.  
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9. Vector Data Formats & Analysis 
All the previous sections have been useful and necessary, but now it’s time to actually start 
answering questions​.​ In this section, we will upload Indiana data layers (from​ ​IndianaMap​) 
and perform some vector analysis.​ Along the way, we will explore a few more vector data 
formats. 

A. Add a Geodatabase File + Query Builder 
Import the​ ‘Vector Analysis/Street 

Centerlines/​County_Street_Centerlines_IDHS_Dec2015.gdb​’ folder.  

 
 
 
 
 
 
 

http://maps.indiana.edu/LayerGallery.html
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Go to the layer’s​ Attribute Table​ to determine ​which field​ will help us extract the Monroe 
County streets: 
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We will use the ‘Origin’ field. 
Go to​ Layer Properties>>>General 

 
 

You should now just have Monroe county streets. Now we will ​save this as a shapefile​. 
>>>​Right click​ on the layer and select​ ‘Save As’ 
NOTE: set CRS to​ EPSG 102674 

 
 
Delete the ​County_Street_Centerlines​ layer, leaving only our new ​monroe_roads​ layer. 
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B. Add a Geojson layer 
 
>>>From ​this link​, click ​Map Service​ under the ​“Schools”​ layer.  
>>>Under ​Layers​, select ​“​Schools (MHMP)​” 
>>>Look at the ​Fields ​in order to decide how to query the layer.  
>>>Under ​Supported Operations​ (bottom the the page), select​ “Query” 
 
To get a peek at the data, perform a ​general query​ to receive ​all records​ in the layer: 

 
 
>>>Be sure​ ‘JSON’​ is selected as the ​Format 
>>>Click ​Query (Get)​ on the bottom for the results.  
 
 
 
 
 
 
 
 
 
 
 
 

http://maps.indiana.edu/layerGallery.html?category=CriticalFacilities
http://maps.indiana.edu/arcgis/rest/services/Infrastructure/Critical_Facilities_MHMP_Schools/MapServer/0
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Scroll down to the first records/feature to see what information is provided: 

 
 
City ​seems to be the attribute we want to isolate in our query.  
We will type ​city=‘Bloomington’ ​and keep everything else the same: 

 
>>>Click ​Query (Get)​ on the bottom for the results.  
>>>Under ​Add Vector Layer​, this time we will choose ​Protocol​, rather than File or Directory.  

 
FINALLY​: Save the query as a shapefile with the consistent projected coordinate system: 
EPSG 102674 
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C. On Your Own 
 
Import ​fire stations​ shapefile and use the query builder to isolate monroe county fire stations. 
Save as shapefile with ​EPSG 102674​ projection. 
 

Tip Stop:​ ​For the Fire Stations & Schools layers, use “SVG Marker” instead 
of “Simple Marker.” This can be done in symbology editor. Choose symbols 

that best represent the entities.  

 
 

D. Distance Buffer 
Let’s answer the question: ​What schools are ​not​ within one mile of a fire station? 
 
Here we will use the ​Fixed distance buffer​ tool.  
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Now we can use the ​select by location​ tool to isolate which schools are ​not​ within 1 mile of a fire 
station. Go to ​Vector ​> ​Research Tools​ > ​Select by location 
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Click on ​Open Attribute Table​ icon and select “​Show Selected Features” 
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E. Shortest Path 
>>>Install the ​“Road Graph”​ plugin. 
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F. Spatial Statistics Tools 
❏ Delete all layers  
❏ New Project 
❏ Set project CRS: 102674 
❏ Add roads layer 
❏ Add Indy tiff 
❏ Create convex hull around roads (​Vector>>>Geoprocessing Tools​) 
❏ Edit polygon to fit in tiff (as done above) 
❏ “Random points in layers bounds” 
❏ Install “Point Sampling tool” Plugin 
❏ Plugins>>>Analyses>>>​Point Sampling tool 
❏ Vector>>>Analysis Tools>>>​Basic Statistics for numeric fields 
❏ Digitize 3 points to​ create new layer 
❏ Vector>>>Analysis Tools>>>​Distance Matrix 
❏ (Summary distance matrix, 1 nearest k target point) 
❏ Vector>>>Analysis Tools>>>​Nearest Neighbor Analysis 
❏ Vector>>>Analysis Tools>>>​Mean coordinates 
❏ To compare point with polygon centroid: Vector>>>Geometry Tools>>>​Polygon Centroid 
❏ Go to tiff layer properties>>>​Histogram​>>>Compute Histogram(if not already there) 
❏ You can save the histogram in a # of formats 
❏ See more statistics in ​Metadata 
❏ Much more analysis available in Processing>>>​Toolbox​!!! 
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10. Raster Data Demo 
In this section, I rely heavily on​ tutorials at this site​.  

A. Vectorizing Land Cover Data with ​Processing Modeler 
❏ MODIS Land Cover 2001 to 2012​ - Identify Change in Grasslands (ND = 10) 
❏ Import both years (​Land Cover 2001 to 2012​ folder) 
❏ Create a model: ​Input > Majority Filter > Polygonize > Extract by attribute > Output 

 
❏ Save the model 
❏ Under​ Processing Toolbox​, go to “Models” and select the model you want to run 
❏ Select parameters (Input and Class Value) 

 
 
 
 
 
 
 
 

http://www.qgistutorials.com/en/index.html
http://www.landcover.org/data/lc/
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B. Terrain Data Work + Google Earth! 
>>>Import city boundary layer (from ​“OSM Bloomington​” folder) 
>>>Import indy.tif from “​Indy DEM​” folder 
>>>​Raster>Extraction>Clipper​ (name output btowm_clip; clipping mode = mask layer; mask 
layer = city boundary) 
>>>Delete indy.tif from project 
>>>Raster>Extraction>Contour: 

 
 
>>>Open contour’s ​Attribute Table​ (each line has an elevation) 
>>>Select highest elevation (280m = 918 ft!) 

>>>Zoom to selection  
>>>​Raster>Analysis>DEM​ (mode= “hillshade”) 
>>>Save contour layer as KML 
>>>Double-click on it and view it in Google Earth! 
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11. BONUS 

A. Adding a WMS (Web Map Service) Layer 
>>>Follow ​this link​ to the Indiana Map website. 
>>>Under ​Hospitals​, click on ​Map Service 
>>>At the top of the page, click on ​WMS 
>>>​Copy the URL 

In QGIS, Click on the ​Add WMS/WMTS Layer​ icon ( ) from the ​Manage Layers Toolbar 

 
 
 
 
 
 
 
 
 
 
 
 
 

http://maps.indiana.edu/layerGallery.html?category=CriticalFacilities
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Connect to layer: 

 
 

B. OpenStreetMap 

C. Actions 

D. Python Console 

E. More Plugins + Other Things 
Cloud, geocoding, ​biological records tool​, ​semi-automatic classification plug-in​, ​qchainage 
(linear referencin), ​Topology Checker Plugin ​ -it could be better 
 
Virtual Layers 
 
 

More to come! This is a working document, so more content will be added periodically. 
Check back in a couple of months! 

 
If you have any questions regarding QGIS (or any other Open Source GIS topic) please to do 

hesitate to contact ​Jacob Mark​, the author of this document, at ​jacobaamark@gmail.com​.  

https://www.youtube.com/watch?v=HKDiOtoAMz0
https://www.youtube.com/watch?v=AE6WALlNicw
https://crocodoc.com/view/WaEqXLKBCFgF0yLelLXbpY5r6xi11s0G9kPmWtJiYkUqkAXErTJrSBTUZR260bHOBZ_MHZ65vC_5HL0e74YdtY1TJfEfaLYRVyeYNdKExvWs0JSEYkcFbAh6OMxahAynoaXHZXMLfE2ngBFWQISagrzfx1JhOX5UtIhPMWgsHEWHYX2B2APj-gLiF3BNa5GJGyDsZblvGAg07JeyNZnOhSqn4OBfvTau
https://www.youtube.com/playlist?list=PLdau3EIomlisHmuJAmjSJ0mNHBIaw6Ep9
https://github.com/mach0/qchainage
mailto:jacobaamark@gmail.com

